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To analyse, émong others, the H-mode data base, a new version
(6.06) of the SAS system has been installed on the VAX 3200 Workstatiom
at JFT-2M. 1In this report, we summarize how to use SAS interactively
(i.e.in 'display manager mode') on this machine. By a didactical
example program and its annotated output we illustrate some of the
capabilities of SAS. The report is intended to facilitate the access
to the SAS documentation by physicists interested in plasma physical

applications.
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Introduction

Recently, the scaling of the energy confinement time of H-mode has attracted much
attention. The knowledge of how the energy confinement time depends on various
parameters, is not only essential as an intermediate step in understanding the physics
associated with the H-mode, but is also inevitable in predicting the performance of future
machines. Hence, a cooperation was established, initiated by the ITER Team,
between the groups of ASDEX, DIII-D, JET, JFT-2M, PBX-M, and PDX to construct a
joint global confinement ‘ITER’ H-mode Database[1-4]. This dataset, containing about
thousand discharges and 75 global plasma parameters, is presently oriented towards H-
mode realized by the NBI heating in the divertor configuration.

There are several statistical packages to analyse such a type of dataset, BMDP, GLIM,
SAS, SPSS, and, on microcomputers, SYSSTAT and various spreadsheet programs.

‘From these, SAS is one of the most extensive and integrated tools among those that are

available on a range of hardware configurations, and is tending to become a standard in
several plasma physical laboratories.

In this report, we summarize how to use SAS on VAX 3200 at JFT-2M, which is,
except for the setting of some laser printer characteristics for graphical output and of a
very few device-specific resource optimization options, fully compatible with SAS ver-
sion 6.06 on another machine. In section 2, the start-up procedure to use SAS
interactively (i.e., in ‘display manager mode’) is described briefly. A physically
motivated SAS example program with explanations and its output are shown in section 3.

How to use SAS on VAX in interactive mode.

In this section, the start-up procedure to use SAS interactively (i.e., in ‘display manager
mode’) on the VAX 3200 at JFT-2M is shown briefly. Bold-face type is used to mark
commands that are to be typed in (if no menu option or function key is used).

VAX specifics:

2.1. Create a new ReGIS VT28X window.

At first, the new window of REGIS VT28X should be created by clicking the left button
of the mouse . This window permits graphical output on the screen. The size of window
should be enlarged to use it effectively. This is done by clicking the corresponding

~ option ‘change size’ in the menu area on the left top comer of the window.

2.2. Login on VAX.

At present, only two users can use SAS on the VAX 3200. The enabled accounts are:
MATSUDA and KARDAUN. '
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2.3. Input @sasini.
The “sasini.com’ is a file containing a few commands to initialize the SAS environment
for the present system.. The file is activated by typing @sasini .
(The commands are actually carried out when SAS is started.)

General SAS statements:

2.4. Input sas.
This is the command to start SAS and go into its ‘display manager’. After this command,
you see the “LOG” and the “PROGRAM EDITOR” window of the display manager on

the screen.

2.5. Input pmenu.

There are essentially 3 ways to input a command to SAS when using the display manager,
(1) by typing a command on the command line, (2) by using the menu system activated
by pmenu, (3) by hitting an appropriate function key. The menu system is a useful SAS
feature . You can use the PF1+ ENTER key to switch between this PMENU SYSTEM and
COMMAND INPUT. In addition to the “LOG”, and “PROGRAM EDITOR” windows,
some extra windows, such as “OUTPUT” and “KEYS”, may be created during a session .
The configuration (relative display) of these windows can be changed by pushing
Cascade, Tile and so on in the View menu. There are important keys to show each
window to the top.

Fl11 go to previous window

F12 go to next window

F17 go to the “LOG” window

F18 go to the “PROGRAM EDITOR” window

F19 go to the “OUTPUT” window

A Tist of all available key settings are shown in the “KEYS” window, which can be
activated by typing Keys in the command line (or by choosing Keys from the Help
menu, or by pressing PF20). For more information, see the SAS Language manual,
Chapter 7 and/or the SAS on-line Help menu.

2.6. The next step is to edit and run a SAS program. To open a file on the “PROGRAM
EDITOR” window, choose Open in the File menu. An overview of the SAS Editor is
given in SAS Language manual, Chapter 8. Important keys for editing are the following
ones (from the numerical key pad):

4key pageup
S5key page down
7key goto thetop
8key goto the bottom.
From the “PROGRAM EDITOR” window, one can submit a VMS command as follows

_2_
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Where v is 8 VMS command. Do not forget to type the *;* , which marks the end
of a SAS statement. (As usual in an IBM environment, the line-numbering region of the
editor serves to place line editing commands, like ¢ for: copy, a for: after this line, m for:
move, ts for: split, upon pushing return, the line at the cursor position, etc.)

2.7. To print out, to save a file and to clear text on a window, choose the item Print in the
File menu, Save as ... in the File menu and Clear text in the Edit menu, respectively.
A VMS filename must be typed with quotes, for instance ‘myfirst_file.sas’. (SAS strips
off the quotes before passing the filename to VMS. ) '

2.8. After making a program, you can submit it by choosing Submit from the Locals menu,
or by pressing the PF3 key. After that, the program will run. You can see the step that is
being carried out in the right top corner on the window.

2.9. A listing of all submitted statements and of any errors (either syntax or run-time errors)
that occurred can be viewed in the LOG window, which, as you know, can directly be
accessed by pushing F17 key.

2.10. After running a program, the “OUTPUT” window is automatically pushed to the top.
There is a useful tool to scan through various parts of the output. This is
Output Manager called from the Globals menu. After that, the F19 key is the switch
between OUTPUT and OUTPUT MANAGER.

3. The Example program of SAS and its output
The usage of SAS is shown by the following Example program and its output The
program should be largely self-explaining by the intersparsed comments. (All text be-
tween * and the next semicolon, and all text between /* and */ is considered as com-
ment, and hence skipped, by the SAS language interpreteter.) The comments that have
been added afterwards (for didactical purposes only) to the output file are typed in italic
font. -

3.1. The input text of the Example program.

**t****************************t*********it*****i*****i**;

*PROGRAM : SASEXAM. SAS .o*y
*AUTHOR({S): ©O. KARDAUN, YU. MIURA (JET2M / IPP) *;
*DATE : 5 MAY 1981 *;
*UPDATE *;
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*INPUT FILES: BDAT.ITHMTI1 *;
*OUTPUT FILES: : *;
/* DIDACTICAL PROGRAM TO ILLUSTRATE THE USE OF SAS,

USING JFT2M DATA FROM THE ITER H-MODE DATABASE. */

/* (NOTATION: WE USE UPPER-CASE AS STANDARD FONT FOR THE
COMMENTS, AND LOWER-CASE AS STANDARD FONT FOR THE
ACTUAL SAS STATEMENTS. THE COMMENTS USUALLY PRECEDE THE
SAS STATEMENTS.)

*/

*SETTING THE MAXIMAL BUFS12E, AS BELOW, SAVES EXECUTION TIME IF
YOU HAVE TO READ LARGE FILES.;

*WHILE NUMBERING THE OUTPUT PAGES, START on hard copy WITH PAGE
NUMBER 1:; .

options bufsize=65024 pageno=1;

*TITLES ARE PRINTED AS COMMENTARY LINES ONTO EACH OUTPUT PAGE
(UNTIL YOU CHANGE THE TITLE);
title 'program sasexam.sas';

*TO PRINT AN OVERVIEW OF THE VARIABLES AVAILABLE IN THE SAS
DATASET ‘ITHMT1l’ (ACTUALLY CALLED: ITHMT1.SASEBSDATA;*) IN
YQUR VMS DIRECTORY:;

* (THE NAME SASUSER POINTS TO YOU OWN DIRECTORY);

title2 'procedure: proc contents data=sasuser.ithmtl;’';

proc contents data=sasuser.ithmtl;

*DEFINITION TO DEFINE A NUMERICAL CONSTANT;
%let pi=3.14159;

*CREATE A NEW TEMPORARY DATASET (WITH THE NAME- JFT2M) :;
data JFT2M;
*THE DATA IN THE FILE JFT2M ARE STORED USING
4 BYTES PER (REAL OR INTEGER) NUMBER. THE DEFAULT IS
8 BYTES:;
length default=4;
*[JSE SASUSER.ITHMT1 AS INPUT DATASET:;

sat sasuser.ithmtl;
*USE ONLY THE ‘STANDARD' ITER SELECTION (WEICH WAS STCRED

INTO THE BINARY VARIABLE PHYSSEL) :;
*IN ADDITIONR TO THIS RESTRICTION, ONLY THE JFT2M
OBSERVATIONS ARE SELECTED:;
‘if physsel=l;
if tok='JFT2M'; _
*KEEP ONLY THE VARIABLES THAT ARE MENTIONED IN THE KEEP
STATEMENT (THE DEFAULT IS TO KEEP ALL VARIABLES) :;
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keep
tok shot time phase
bt ip nel nev pinj pabs

rgeoc amin kappa
taudia taumhd wdia wmhd
gas dn elm

r

ran;

*CALCULATE THE MEAN VALUES AND SOME OTHER SUMMARY STATISTICS
FOR THE SPECIFIED VARIABLES:;

title2 'procedure: proc means data=jft2m;"';

proc means data=jft2m;

var
taudia taumhd wdia wmhd
bt ip nal nev pinj pabs
rgeo amin kappa
gas dn elm

run;

*MAKE AN EXTENDED DATASET (CALLED JFT2ME) WITE SOME EXTRA,

DERIVED VARIABLES;
data jft2Zme;
length default=4;
set jft2m;
ltaudia=log(taudia)};
ltaumhd=log (taumhd);
ltmmd=ltaumhd-ltaudia;
*USING ‘ENGINEERING UNITS’ :;
elbt=log{bt);
elip=log(ip/1l.0Ce6);
elnel=log(nel/l,0e20);
elnev=log(nav/1.0e20);
elpinj=log(pinj/1.0e6);
elpabs=lcg{pabs/1.0e6);
elwdia=log (wdia/l.0e6);
elwmhd=log (wmhd/1.0e6);
*T0 PJSE THE CONSTANT PI, DEFINED ABOVE:;
elbtr=elbt-log{2*spi*rgeo):
*MAKE A DESCRIPTIVE LABEL FOR VARIABLES FOR WHICH IT IS

THOUGHT USEFUL; .

* (VARIABLE NAMES CANNOT BE LONGER THAN 8 CHARACTERS,
LABEL NAMES MAY BE UP TO 40 CHARACTERS. LONG LABELS MAY
SOMETIMES PRODUCE AN UGLY OUTPUT APPEARANCE, HOWEVER.);
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label ltmmd = 'log(taumhd/taudia)’
elm= 'elms (0=no,l=yes})’
gas='1l=H, 2=D (av. of plasma and bean)'’
dn= 'config (0=SN,1=DN)"';
run;

*PRESENT SOME MORE DETAILED UNIVARIATE STATISTICS,
INCLUDING SOME LINEPRINTER GRAPHS,
OF THE SPECIFIED VARIABLES:;
title2 ‘'procedure: proc univariate data=jft2me plot;’';
proc univariate data=jft2me plot;
var taudia taumhd ltmmd;
run;

*MAKE A FREQUENCY TABLE: ELM VERSUS

ALL COMBINATIONS OF DN AND GAS, INCLUDING TOTALS:;
* (FOR FURTHER INFORMATION ABOUT SUCH, AND MORE
COMPLICATED, TABLES SEE THE SAS PROCEDURES

GUIDE, CEAPTER 37);

title2 'procedure: proc¢ tabulate data = jft2me, etec.';
proc tabulate data = jft2me format=6. noseps;

class dn gas elm; '

table (elm all), (dn*gas all);

run;

*MAKE THE CORRELATION MATRIX FOR SOME VARIABLES:;

* (THAT ARE THQUGHT TO BE OF POSSIBLE USE AS
CONFINEMENT TIME REGRESSORS);

title2 'procedure: proc corr data=jft2me;’';

proc corr data=jft2me;

var elbt elip elnel elpabs;

run;

*PERFORM A PRINCIPAL COMPONENT ANALYSIS FOR THESE
VARIABLES:;
* (BASED ON THE CORRELATION MATRIX, WHICH MEANS THAT
ONE STANDARD DEVIATION, AS ESTIMATED FROM TBE DATASET,
IS CONSIDERED EQUALLY IMPORTANT FOR ALL VARIABLES);
title2 'procedure: proc princomp data=jftZme;’;
proc princomp data=jftZme;
var elbt elip elnel elpabs;
run;

*PERFORM A PRINCIPAL COMPONENT ANALYSIS FOR THESE
VARIABLES:
* (NOW BASED ON THE COVARIARCE MATRIX, WHICH MEANS THAT
A CONSTANT FACTOR, FOR INSTANCE E=2.718... ,
I8 CONSIDERED EQUALLY IMPORTANT FOR ALL VARIABLES);

i6_
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title2 'procedure: proc princomp data=jft2me covariance;';

proc princomp data=jftZme covariance;
var elbt elip elnel elpabs;
run;

*LET US PERFORM A REGRESSION ANALYSIS:;

* (BECAUSE THE ‘STANDARD SELECTIQN' CHOPPED OFF
THE EXISTING B_T SCANS IN THE DATA,
THE ABOVE 4 VARIABLES ARE ILL-CONDITIONED.
FOR DIDACTICAL REASONS, WE NOW MAKE THE (STRONG} ASSUMPTION
THAT THERE IS NO B-DEPENDENCE, AND OMIT B FRCOM THE
REGRESSION. FURTHERMORE, WE RESTRICT THE EXPONENT OF THE
ISOTOPE EFFECT TO BE 0.5.);

title2 'procedure: proc reg data=jft2me;’';

proc reg data=jft2me;
model ltaumhd ltaudia = elip elpabs elnel gas;
raestrict gas=0.5;
run;
quit; *to stop proc reg entirely;

*WE MAKE A DATASET WITH ONLY THE ELM-FREE DISCHARGES, ;
data jft2mnel; '

set jft2me;

if elm=0;

run;

*RUN, FOR DOCUMENTATION, PROC CONTENTS, ;

title2 'procedure: proc contents data=jft2mnel;’;
proc contents data=jft2mnel;

run;

*AND PERFORM THE REGRESSION AGAIN, NOW FOR TAU(MHD) AND
ELM-FREE DISCHARGES ONLY,

APPLYING NO RESTRICTION ON THE EXPONENT FOR GAS:;
title2 'procedure: proc reg data=jft2mnel;’;
proc reg data=jft2mnel;

model ltaumhd = elip elpabs elnel gas;

run;

quit; *to stop proc reg entirely:;

*WE VERIFY THAT THE CONDITION IS REASONABLE BY USING
PROC PRINCOMP ON THE ELM-FREE DATASET, AND INCLUDING
GAS AS AN EXTRA VARIABLE:;

* (BASED ON THE COVARIANCE MATRIX, WHICH NOW IMPLIES THAT

CHANGING THE VARIABLE GAS ONE UNIT IS CONSIDERED
AS IMPORTANT AS CHANGING THE OTHER VARIABLES
BY A FACTOR E=2.718);
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title2 'procedure: proc princomp data=jft2mnel covariance;';
proc princomp data=jft2mnel covariance;

var elip elnel elpabs gas;

run;

*WE USE PROC GLM TQ INVESTIGATE INTERACTION BETWEEN TEHE

POWER DEPENDENCE AND TEE ISOTOPE EFFECT::

* (SUCH AN INTERACTION WAS SUSPECTED BY JFT2M FROM
OFFSET-LINEAR TYPE SCALING ANALYSES);

* (FOR MORE INFORMATION ON PROC GLM, SEE THE SAS/STAT USER'S

GUIDE, CHAPTER 24):
title2 'procedure: proc glm data=jft2mnel;’';
proc glm data=jft2mnel;
class gas;
model ltaumhd = gas elip elnel elpabs(gas) /solution;
output out=jftnelpr p=ltaumhdp r=ltaumhdr;
* (The last statement is optional. It serves to make
an output dataset, called jftnelpr, which consists of the
original dataset (jft2mnel), to which are added the variableas
ltaumhdp and ltaumhdr. These contain the p(redicted) values
of ltaumhd and the r(esidual), i.e. observed minus predicted,
values of ltaumhd, respectively.):

run;

*TQ END THE GLM PROCEDURE:;

* (OTHERWISE THIS IS ONLY DONE BY THE NEXT DATA STEP OR PROC
STEP, AND INTERMEDIATE ‘OPTION STATEMENTS'’, ETC. WILL BE
OVERLOOKED. THE SAME APPLIES TO PROC REG AND PROC GPLOT);

quit;

*NOW WE ARE GOING TO MAKE A RESIDUAL PLOT:;
*FOR MORE INFORMATION, SEE THE SAS/GRAPH USER’S MANUAL;
* (THE ANNOTATE DATASET IS USED TO DRAW THE LINE 'Y=X');

data anno;
*data value for x, data value for y;

retain =xsys '2' ysys '2';

function= "move'; x=-4.5; y=-4.5; output;

function= 'draw'; x=-2.5; y=-2.5; output;
run;

*FOR MAKING THE PLOCT ON THE VTZ286 SCREEN:;

goptions reset=all;

goptions display cback=white device=vt286
hsize = 16.0cm wsize = 16.0cm;

title 'MHD confinement for ELM-free JFTZM discharges';
title2 'Power-law scaling with interaction between gas and
Pabs';
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title3 'Observed versus predicted from proc GLM';
* ({THE PLOT INFORMATION IS STORED IN THE GRAPHICAL CATALCG
jftnelpr);
proc gplot data=jftnelpr gout=sasuser.jftnelpr;
*THE AXIS STATEMENT IS OPTIONAL, BUT MAKES A NEATER GRAPH:;

axisl order {-4.5 to -2.5 by 0.5)
value =(h=1.5) width=1
offset=(0,0) length=8 cm;

plot ltaumhd*ltaumhdp/ fr vaxis=axisl haxis=axisl
annotate=anno;

an;

*TO REPLAY THE PLOT FROM THE GRAPHICAL CATALCG:;
proc greplay igout=sasuser.jftnelpr;
run;

*FOR A GOOD HARD-COPY ON THE TEKLNO3 LASER PRINTER,
THE GOPTIONS ARE CHBANGED:;
* (THE GRAPHICAL INFORMATION IS NOW STORED IN A SO-CALLED
GSF FILE, WHICH WE IDENTIFY BY THE NAME SASEXAM);
filename sasexan 'sasexam.gsf’;
goptions device=tekln0l gsfname=sasexam
gsfmode=replace
hsize = 17.0cm wvaize = 17.0cm
nodisplay noprompt neocharacters ;

*AND GPLOT IS RUN AGAIN:;
proc gplot data=jftnelpr;
axisl order (-4.5 to -2.5 by 0.5)
value ={h=1.5) width=1
offset=(0, 0} length=10 cm;
plot ltaumhd*ltaumhdp/ fr vaxis=axisl haxis=axisl
annotate=anno;

run;
quit;

*WE ISSUE A VMS COMMAND TO SEND THE GSF FILE TO THE LASER
PRINTER: ;

x print/passall sasexam.gsf;
****************endsas************;

Figure 1 shows the graphical output from the laser printer.

3.2. The SAS output from the Example program.
The SAS output from the Example program was transferred to a word- processor on
Macintosh and provided with some explanatory comments, typed in italic font.
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MHD confinement for ELM—free JFTZ2M discharges

Power-lax scaling with interaction between gos and Pabs
Observed versus predicted from proc GLM
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Fig.1 Graphical output from SAS.



